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Introduction
Graphics VP Deluxe (GVPD) is an application designed to help you view, print, acquire, convert, and 
resize picture files.
    
It supports class conversion to Bilevel, Gray Scale, Palette, and True Color.    You can reduce image 
file size using different file compression formats such as LZW, RLE, CCITT, and JPEG.

It offers lots of image enhancement features like resize, rotate, flip and filters like brightness, 
contrast, sharpen,    blur, noise removal, emboss, sculpt, and more. 

There are built in links to other graphics programs such as image editors. 

It includes a Graphics Gallery program which is designed to help you find, organize, display, and 
print your picture files.    Multiple picture files are displayed in an re-sizeable gallery which you can 
organize, sort, delete, and save to a file as thumbnails so you can quickly view them again.    You can
also run a slide show from the gallery or a list of picture files. 

It supports many different kinds of picture file formats such as BMP, PCX, TIF, GIF, JPG, PIC, PCD, 
FLT, RAS, TGA, CUT and more.



Quick Start

Overview
To begin using Graphics VP Deluxe, double click on the icon in Program Manager created by GVPD 
SETUP.EXE or double click on GVPD.EXE in File Manager.    

Pictures can be scanned into GVPD using a TWAIN-compatible scanner, inserted from an existing 
file, or pasted from the clipboard.    

GVPD can be used to view, enhance, convert, or print the images.    You can bring up multiple 
images at one time.

It comes with a Graphics Gallery companion program to help you view and manage a collection of 
images through a visual gallery of image thumbnails.

Program Settings

About Images
Images are composed of elements that are called pixels.    A pixel is the smallest element that can be
displayed on a computer or printed on a printer.    Each pixel in an image can be represented by a 
collection of smaller dots, or bits.    The number of bits per pixel determines the number of colors or 
shades of gray that can be displayed or printed. 

The higher the number of bits per pixel, the more colors or shades of gray are possible. 

This number of bits Can display
1 bit per pixel 2 shades -- black and white
4 bits per pixel 16 colors or shades of gray
8 bits per pixel 256 colors or shades of gray
24 bits per pixel 16.7 million colors

Refer to the Graphics VP Deluxe and Graphics Gallery Help Files for more information.

See Also
Image Class Information
Image Compression Information
File Format Information
Bilevel Halftones



Program Settings

Program Linkage
You can setup a link to other programs from Graphics VP Deluxe by entering the directory path and 
program file name using SETUP from the OPTIONS Menu.

One link can be used for your favorite Graphics Editor program, for example Paint Brush.    The Other
can be used for your favorite Gallery Thumbnail Display program, for example Graphics Gallery by 
SkiSoft Shareware.

You have the option of setting these to what ever program you want.    For example you can set them
to other graphics programs or even word processing programs.

Enter the full path and program name or click on the Open Dialog buttons to the right of each text 
box.    Find the program you wish to enter using the Open Dialog and click the OK button. 

When done, click the OK button on the Program Settings Form

Scroll Control
You have the ability to adjust the Window scrolling increment.    The reason you may want to do this 
is because images with higher resolutions will move slowly with a small increment while low 
resolution images will move fast.    The Large Increment occurs when you click on the inner scrollbar. 
The Small Increment occurs when you click on the outer arrows of the scrollbar.    The defaults are 
Large - 16 and Small - 6. The input range is from 1 to 32,767.

Position Zoom Control
The Position Zoom Factor sets how much of an increase or decrease is used during a position zoom.
Position zoom occurs when you see the cross-hair mouse pointer and click on the current image.    
The default is 7 and the input range is from 1 to 1500.



Image Class

Image Class information
The image class of an image is based on the number of bits per pixel in the image.    GVPD supports 
bilevel (1-bit, 2-shades), gray scale (8-bit, 16-shade), palette (8-bit, 16-color), True Color (24-bit, 16.7
million color).

Image classes:

Bilevel
Gray Scale
Palette
True Color

See Also
File Format Information
Image Compression Information
Halftone Information



Bilevel images use a single bit to represent a pixel.    Each pixel is interpreted as completely black (0)
or completely white (1).    Bilevel images are often referred to as "Black and White", "Line Art", or 
"Halftones".



Gray Scale images use 8 bits to represent a pixel.    A value in this kind of image represents a level of
grayness on a continuous-tome scale ranging from completely black (0) to completely white (255).



Palette images use 8 bits to represent a pixel.    Unlike all other image classes, however, a Palette-
class pixel does not represent an intensity level.    Instead, the pixel value is an index to an entry in 
the image's "palette".    Palette format is frequently used to encode color images containing less than 
255 colors because it consumes significantly less space than True Color form.



True Color images use 3 bytes (24 bits) to represent a pixel.    The first byte represents the pixel's 
Red value, the second byte its Green value and the third byte its Blue value.    The value in each byte
denotes the intensity of its respective color.    By varying the levels of Red, Green, and Blue, over 16 
million different colors can be represented.



Supported File Formats
The file format of an image is based on its image class, compression type, and halftone pattern if the 
image is bilevel. 

Graphics VP Deluxe supports the following file formats:

*.BMP   Bitmap File Format, also .DIB and .RLE.  Both Windows and OS/2 
formats.
*.CUT   HALO Device Independent Image File Format.
*.DCX   Intel File Format.
*.EPS   Encapsulated Postscript File Format (Read only).
*.FLT   Flat File Format
*.GIF   Graphics Interchange Format, CompuServe.
*.JPG   JPEG File Interchange Format V1.02.
*.PCX   ZSoft Image File Format.
*.PIC   Apple Macintosh PICT Format, also .PCT.
*.PCD   Kodak PhotoCD (Read only)
*.RAS   Sun Rasterfile Format or Raster.
*.TGA   Truevision TGA or Targa.
*.TIF   Tag Image Format or TIFF.  Classes X, B, G, R, and P.

See Also
Image Class Information
Image Compression Information
Halftone Information



Compression
You can compress an image when you save it so that it requires less memory to store it.    There are 
two types of compression, Lossless and Lossy.    Lossless allows full recovery of the original image 
and Lossy degrades the image during compression.

The following information shows the image classes and file compression
methods supported for each file format:



FORMAT        CLASS           DEFAULT         OTHER SUPPORTED
                              COMPRESSION     COMPRESSIONS
---------------------------------------------------------------
     1        0 - Bilevel     3 - CCITT 1D    0, 2, 4, 5
  (TIFF)      1 - Gray Scale  7 - LZW Horz    0, 2, 6
              2 - Palette     7 - LZW Horz    0, 2, 6
              3 - True Color  7 - LZW Horz    0, 2, 6

     2        0 - Bilevel     0 - None        -
(BMP/DIB)     3 - True Color  0 - None        -
              1 - Gray Scale  2 - RLE         0
              2 - Palette     2 - RLE         0

     3        0 - Bilevel     Not supported   -
(HALO Cut)    3 - True Color  Not supported   -
              1 - Gray Scale  2 - RLE         -
              2 - Palette     2 - RLE         -

     2        0 - Bilevel     2 - RLE         -
  (PCX)       1 - Gray Scale  2 - RLE         -
              2 - Palette     2 - RLE         -
              3 - True Color  2 - RLE         -

     5        0 - Bilevel     0 - None        -
(Adobe EPS)   1 - Gray Scale  0 - None        -
              2 - Palette     0 - None        -
              3 - True Color  0 - None        -

     6        0 - Bilevel     Not supported   0
 (Targa)      1 - Gray Scale  2 - RLE         0
              2 - Palette     2 - RLE         0
              3 - True Color  2 - RLE         0

     7        0 - Bilevel     6 - LZW         - 
  (GIF)       1 - Gray Scale  6 - LZW         -
              2 - Palette     6 - LZW         -
              3 - True Color  Not supported   -

     8        0 - Bilevel     2 - RLE         0
(Rasterfile)  1 - Gray Scale  2 - RLE         0
              2 - Palette     2 - RLE         0
              3 - True Color  2 - RLE         0

     9        0 - Bilevel     Not supported   -
 (JPEG)       2 - Palette     Not supported   -
              1 - Gray Scale  8 - JPEG        Quality factor of 0-100 %
              3 - True Color  8 - JPEG        Quality factor of 0-100 %

    10        0 - Bilevel     2 - RLE         0
  (PICT)      1 - Gray Scale  2 - RLE         0
              2 - Palette     2 - RLE         0
              3 - True Color  2 - RLE         0

    11        0 - Bilevel     Not supported   - 
  (PCD)       1 - Gray Scale  Not supported   -



              2 - Palette     Not supported   -
              3 - True Color  Not supported   -

    12        0 - Bilevel     Not supported   - 
  (FLT)       1 - Gray Scale  Not supported   -
              2 - Palette     Not supported   -
              3 - True Color  Not supported   -

See Also
Image Class Information
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Halftone
A halftone image is an image that is composed of only black and white.    Halftones are especially 
useful if you are transferring an image into an application that does not accept color or gray scale 
images, or printing to a printer that doesn't print in color.

The spatial resolution of an image (its height and width) is measured in lines of dots per inch or LPI.   
In general, the higher the LPI value, the less obvious the pattern created by the halftone, but the 
lower the number of distinct shades of gray.

A halftone has a specific pattern of black and white dots.    GVPD supports the following types of 
screens:

Bilevel Threshold
Converts the current MDI image to Bilevel using the threshold method.    This technique converts all 
gray shades above 50% brightness to white, and all shades below 50% brightness to black.

Bilevel Haftone
Dot Screens

Use varying sized dots to represent shades of gray.    the angle dot screen is the most commonly used, and often 
produces the best results.

Line Screens
Use lines of varying thickness to represent shades of gray.    Lines may be angled, or oriented horizontally or 
vertically.

Diffuse Screens
Use error diffusion to simulate shades of gray with seemingly random patterns.    diffuse screens often give a 
smoother look to output, and are more effective at lower resolutions. 



Graphics VP Deluxe General Information
Features
· Extensive file format support, including support for TIFF, JPEG, BMP, PCX, DCX, FLT, PICT, GIF,

Kodak PhotoCD, HALO Cut, Targa, and Sun Rasterfile.
· Acquire from Twain compliant devices.
· Multiple MDI window images visible at one time.
· Image Printing with sizing, print dither, and smoothing.
· Zoom and Resize
· Class Conversion: Bilevel, Gray Scale, Palette, 24-bit True Color.
· File Compression methods LZW, RLE, CCITT, JPEG
· JPEG quality factor selection when saving.
· Other graphics program links to programs like Graphics Gallery.
· File Manager Association
· Drag & Drop: View files dragged from File Manager.

Tips
 1. You can assign picture extensions to File Manager so you can double click on a picture name and
it will start Graphics VP Deluxe.    Make sure you specify GVPD.EXE when assigning the program 
name in File Manager.

 2. The lower status bar lets you know of information pertaining to the display image.    This includes: 
Format, Class, Size, and Compression..

 3. The upper toolbar will show Tooltips when you rest the mouse pointer over the button.    This will 
remind you of the buttons purpose.

 4. You can activate help at anytime with F1.    Help will be displayed for the function you are currently
working with.    You can also get help from the HELP MENU and HELP toolbar button.

 5. Click the right mouse button over the MDI image windows for a pop-up menu.

 6. Closing down MDI image windows that have been changed will prompt you to save the changes 
first.



Graphics VP Deluxe Functions

Acquire
Twain compliant image capture.

Clip
Selecting a clip region from an image.

Convert
File format, compression, and class information.

Drag Drop
From File Manager to GVPD.

Editing
Copy/cut/paste, undo, and select.

Files
New images, opening and saving images.

Filter
Image enhancement (sharpen/soften) and special effects (sculpt/emboss).

Luminance
Bright, contrast, gamma control.

Printing
Printing an image and print setup.

Program Settings
Scroll increments, editor/gallery program links.

Resize
Select a size, ratio, smoothing.

Screen Capture
Capture other Windows into GVPD.

Short Cut Keys
Keyboard shortcuts.

Zoom
Zoom in/out, position zoom, zoom toolbar.



Menu: Acquire
Allows you acquire an image from any Twain compliant device such as scanners, digital cameras, or 
frame grabbers. 

The Twain standard requires the hardware manufacturer to provide user-interface software with their 
product.    The Graphics VP Deluxe Acquire command invokes this interface.

· You can select which acquire device you will use by clicking on the Select Button.
· The View Clipboard button will show the contents of the Windows Clipboard.
· You can direct your acquired image to the Image Control, a File, or the Clipboard.
· Using the Close Button will transfer the Image Control contents or file to an MDI image window in

Graphics VP Deluxe.
· The Cancel Button will not transfer the acquired image to Graphics VP Deluxe.



Clip
The clip feature turns on and off with a single click of the left mouse button on the Clip toolbar button 
or by using the Clip option from the View menu.    

To create a clip region you hold down the left mouse button and drag the mouse.    If you want to 
select the entire image use the SELECT, ALL option from the EDIT menu.    If there is no selection, 
the entire image is automatically selected.

You can select all or part of an image to copy or cut to the clipboard by defining a clip region.    Then 
you can paste from the clipboard to a selected part of the same image or to another image.    The 
paste will default to the upper left hand corner.    If you want to position where the paste will go, you 
need to create another clip box at the location you desire before doing the paste.

The Clip Measurement Box on the status bar will show you clip Width x Height measurements.    
When clip is off you will see the cursor location over each image.    When clip is on you will see the 
starting and ending locations of the clip box as well as the size of the clip box.



Convert
Use to convert the current MDI image to another image class.    To convert the current MDI image, 
you use the CLASS CONVERSION options from the IMAGE Menu or Save As Dialog.

 NOTE - if you want to convert the picture to another format (ie. .BMP, .JPG, .GIF) use Save As.      In 
some situations, you must convert the image class before changing the format.    For example, when 
converting from GIF to JPG you must first convert the image class from Palette to True Color or 
Grayscale.

See Also
Image Class Information
File Format Information
Image Compression Information
Bilevel Halftones



Drag Drop
You can populate Graphics VP Deluxe with images by dragging one or several files from File 
Manager to the main Graphics VP Deluxe Window or it's minimized icon. 



Menu: Edit

UNDO
Will undo the last change made to the current MDI image.    Each image displayed has it's last 
change saved.

COPY
Will copy the current MDI image or clip portion to the clipboard.

COPY TO NEW
Will copy the current MDI image or clip portion to a new MDI image.

CUT
Will cut the current MDI image display or clip portion to the clipboard.    This will erase the selected 
part of the original image.

PASTE TO IMAGE
Will paste the contents of the clipboard to the current MDI image.    The default position is the upper 
left hand corner of the receiving image.    To position a paste, create a clip box at the desired location.
The contents of the clipboard must be a graphics format.

PASTE TO NEW
Will paste the contents of the clipboard to a new MDI image.

PASTE TO SPECIAL
Will paste the contents of the clipboard to a new MDI image.    See also Paste Special Information.

SELECT
· NONE - No part of the current MDI image is selected.
· CREATE - Will turn the clip option on so you can create a clip box.
· ALL - Will select the entire contents of the current MDI image.    Use to cut/copy/paste the entire image.    Will also 

reset the clip box.    This is the default if no clip box is set.



Graphics VP Deluxe Files
The following file features are available.    They can be accessed from the menu or from the main 
toolbar.

New
Creating a new MDI window can be done from a scan, from the clipboard, from a paste new, or you 
can create a new blank picture.

Open
Opens an existing image in a new window.    You can also open one of the most recently saved 
images by selecting the name from the bottom of the File menu or clicking the Open Button on the 
GVPD main toolbar.    See also Open File.

Close
Closes the current MDI image.    If there were changes, you will be asked if you want to save the file.  
If you close an image without saving, you will lose all of the changes that have not previously been 
saved.

Save
Saves the current MDI image using the current name, location, format, and image class.    If there is 
not a name, it will default you to Save As.

Save As
Save As allows you to save the current MDI image to a different directory, file name, graphics format,
and/or graphics class.    For certain picture types you can also set the compression factor, and adjust 
the picture quality.    See also Save File As.

Append
Saves the current MDI image using the current name, location, format, and image class.    If there is 
not a name, it will default you to Save As.

Delete
Saves the current MDI image using the current name, location, format, and image class.    If there is 
not a name, it will default you to Save As.



Filter
Filtering modifies the rate of change that occurs along feature edges in an image.    It can increase 
the intensity differences in a soft edge to make it appear sharper, or reduce the intensity difference in
a hard edge to smooth and soften it.

Filtering only works with certain picture formats.    If your format does not work you must convert the 
picture to a "True Color" or "Grayscale" class first.    

To apply filtering to the current MDI image or a selection from an image, you click on the Filter 
Preview button on the main toolbar or select the Filter option from the Image menu.    Some filter 
operations require strength and size input.    

To reset the changes, click on the Undo button on the main toolbar. 

The following is a list of available filters:

Edge Detection
· Thin Edge Detection - traces all edges with a thin line.
· Thick Edge Detection - traces all edges with a thick line.
· Horizontal Edge Detection - traces horizontal edges.
· Vertical Edge Detection - traces vertical edges.

Sculpt
· Sculpted, lit above
· Sculpted, lit left
· Sculpted, lit upper
· Metallic - produces a shiny, metallic look

Emboss
· Embossed, lit above
· Embossed, lit left
· Embossed, lit upper

Line Detection
· Horizontal Line Enhancing - accentuates horizontal edges and de-emphasizes everything else.
· Vertical Line Enhancing - accentuates vertical edges and de-emphasizes everything else.
· Horz/Vert Line Enhancing - accentuates vertical and horizontal edges and de-emphasizes everything else.

Soften/Blur
· Softening - blurs the image.    Strength represents the strength at which the filter is to be applied (0-100, 100 is full 

strength).

Noise Removal
· Noise Removal - or despeckle, removes noise from the image.    Sensitivity is specified in Strength ( 0 to 100).    Kernel

size is specified in Size and must be a value of 3, 5, or 7.

Invert
· Inverting - produces a negative image.

Pixelize
· Pixelizing - pixelizes the image by averaging the contents of FilterSize x FilterSize areas.

Posterize
· Bit Depth Reducing - or posterize, reduces the number of levels in an image by eliminating the least-significant bits in 

each pixel.    Size must specify the number of most-significant bits to retain.

Sharpen
· Sharpening - sharpens the image.    Strength should specify a value from 0 to 100, 100 is full strength.





Luminance Toolbar
Used to adjust the Brightness, Contrast, or Gamma of an image.

Black and White or Gray Scale images will only use one luminance slider.    Color images will have 
all, red, green, blue adjustments.

Brightness
Contrast
Gamma



Brightness
Used to adjust the brightness of an image.    In color images (True Color or Palette) brightness can 
be applied to the entire image (Lum:) or to a selected color channel, Red:, Green:, or Blue:.    

To change the brightness of the current MDI image, click on the Luminance button on the main 
toolbar and select Bright on the custom toolbar or use the Brightness Control option of the Image 
menu. 

Brightness values range from 0 to 100, where 50 represents no change to the original image.    
Values less than 50 reduce brightness (darken the image) and values greater than 50 increase 
brightness (lighten the image).



Contrast
Used to adjust the Contrast of an image.    Contrast adjustments will change the difference between 
the lightest and darkest values in an image.    In color images (True Color or Palette) brightness can 
be applied to the entire image (Lum:) or to a selected color channel, Red:, Green:, or Blue:.    

To change the contrast of the current MDI image, click on the Lumimance button on the main toolbar 
and select Contrast on the custom toolbar or use the Contrast Control option of the Image menu. 

Contrast values range from 0 to 90, where 45 represents no change to the original image.    Values 
less than 45 reduce contrast      and values greater than 45 increase contrast.



Gamma
Used to adjust the gamma of an image.    Gamma adjustments will increase the contrast in the image
mid tones without affecting its highlight (white) and shadow (black) points.    In color images (True 
Color or Palette) gamma can be applied to the entire image (Lum:) or to a selected color channel, 
Red:, Green:, or Blue:.    

To change the gamma of the current MDI image, click on the Lumimance button on the main toolbar 
and select Gamma on the custom toolbar or use the Gamma Control option of the Image menu. 

Gamma values range from .1 to 9.7, where 1.00 represents no change to the original image.    Values
less than 1.00 reduce gamma, which will increase contrast in the lighter regions, and darken the 
image overall.    Values greater than 1.00 will increase the contrast in the darker regions, and 
brighten the image overall.



Graphics VP Deluxe Printing
You can use Graphics VP Deluxe to print your images in color or black and white.    Before printing 
you can adjust the brightness, contrast, or gamma of an image.    You can also resize, rotate, and 
crop the image before printing.    You can sharpen or soften the appearance of an image, clean up 
unwanted specks, posterize, or create the negative of an image using filters.

Use the Print Image File menu option to print the currently selected MDI image to your printer.    
Selecting this menu option brings up print setup for the display image.

Print Setup



Print Setup
This Windows Dialog Box is used to setup the printing of an image in Graphics VP Deluxe.    You can 
use the default values or input your own.

Position
· Used to specify the top margin on the page.    This is where the image will start printing the selected inches from the top 

of the page.
· Used to specify the left margin on the page.    This is where the image will start printing the selected inches from the left 

of the page.

Size
· Scale the printed output to a specific width and height.    This can be set in either inches or as a percentage of the actual 

image size.
· Allow Distortion which scales the height and width fields independently.    If not checked, the height and width fields will 

change automatically to maintain the aspect ratio of the image.
· Smoothing which can reduce the jagged edges if a printed picture is being resized.
· Actual Size which will return the height and width fields to their original values.
· Fit To Page automatically scales the image to its largest possible dimensions given the current printer page size.

Printer
· Shows you your Windows default printer name.    You can change this using the Windows control panel.

Halftone
· Halftone type - Angle Dot should be the default for standard printing.    The other halftone types will create special effects 

during printing.
 - Angle Dot 
 - Flat Dot
 - Angle Line
 - Horz Line
 - Vert Line
 - Error Diffusion
 - Threshold
 - Printer Halftone

· SCREEN SIZE    - This option will show a number ending with lpi (lines per inch).    The numbers will vary depending on 
the graphic resolutions supported by your printer.    The higher the number, the better the resolution.



Resize
Resize is used to change the image's height and width to a specified size.    Resizing permanently 
changes the image data but does not automatically save it back to the file.    You can select this from 
the RESIZE option under the IMAGE menu.    If you want to enlarge or reduce an image for display 
purposes only, use ZOOM options from the VIEW menu. 

If you want to resize part of an image, select the area you want to resize.    GVPD resizes only the 
area you select, and automatically deletes the rest of the image.

Select a Size...
You can resize an image based on a predefined height and width by selecting a size such as 320 x 
200 or choose Custom Size and enter your own height and width. 

Select Units
You can show the resize width and height in pixels or inches.

Maintain Ratio
When using the Custom Size height and width you can check Maintain Ratio.    When Maintain Ratio 
is checked,    an entry in the height input box will automatically input the width based on the display 
image's original height to width ratio and visa versa.

Smoothing
When smoothing is checked, bilinear smoothing will occur during scaling.    This compensates for 
pixels that are added or lost when the image is resized.    Smoothing increases processing time, but 
produces the best result.    If smoothing is not checked, scaling is faster, but the image may result 
with jagged edges.



Screen Capture
Graphics VP Deluxe will accept and print Windows screen captures.    The following explains how 
you can capture a window and bring it into Graphics VP Deluxe.

· To capture a single window you make that window active and press the Alt-Print Screen keys at 
the same time.    This places the window image on the clipboard.    Then in Graphics VP Deluxe 
you open a new MDI window and select the EDIT:PASTE menu.    This copies the image on the 
clipboard to the new MDI window.    Save the image to a file format you choose and use 
FILE:PRINT IMAGE to print it or you can import it to your Word Processor.

· To capture the entire Windows desktop by pressing the Print Screen key.    Follow the procedures
in #1 to import the clipboard image to Graphics VP Deluxe.

· To capture a portion of the display, follow the steps for (1) or (2) above.    While in Graphics VP 
Deluxe, click on the image once to turn on the clip function.    Select the portion you wish to 
capture by dragging the mouse.    Then use copy/cut/paste to an new image window to display 
your captured image.



Short Cut Keys
F5 Fit To Parent Window
F6 Fit To Picture
F7 Fit To Image Window
F8 Custom Zoom

Ctrl-A Save As
Ctrl-CCopy
Ctrl-E Graphics Editor Link
Ctrl-F Full Screen, Picture Size
Ctrl-GGraphics Gallery Link
Ctrl-I Acquire
Ctrl-K Show Short Cut Keys
Ctrl-NNext MDI Window
Ctrl-OOpen
Ctrl-P Print Image
Ctrl-S Setup
Ctrl-V Paste To Image
Ctrl-X Cut
Ctrl-Z UNDO

ESC End Full Screen View

Right Mouse Click - over MDI windows will bring up pop-up menu.
Double Left Mouse Click - on the MDI windows will show image as full screen. 



Zoom
Displays the image at a percentage of its original size.    You can make it easier to edit the image by 
magnifying the view, or display the entire image by reducing the view.

You can also zoom in or out on part of an image by using the position zoom option on the view 
toolbar.    Position zoom will try to keep the part of the image you click on in the center of the view.

The zoom will apply to the currently selected MDI image.    Zoom does not make a permanent 
change to the image file.

View Menu
You can choose the ZOOM option from the View menu to choose a magnification from 10% to 
1000%.    100% will bring the image back to it's normal size.    

View Toolbar
From the VIEW menu, the toolbar, or the F8 key you can display the Custom Zoom Toolbar.    It is 
used to enter a custom zoom percentage (from 1 to 1600), move the zoom slider to increase or 
decrease the zoom, or click on the 100% zoom button to return to normal size.      The Zoom Toolbar 
also allows you to set scrollbars and position zoom.

Note
Use the keyboard arrow keys and PageUp/PageDown keys to control the zoom scrollbars on the 
active MDI image.



Graphics VP Deluxe Menu
Graphics VP Deluxe Menu options.    Some options are not shown until there is an open image 
window.

File
Edit
Options
View
Image
Tools
Window
Help



Menu: File

NEW
Creates a new, empty MDI graphics window.    The MDI windows will resize automatically when an 
image is copied to the window.

OPEN
Brings up the open file dialog box which you use to open a picture file in a new MDI image window.    
See also Open File.

CLOSE
Closes the current MDI image.    If it has been changed, you will be prompted to save the changes.

SAVE
Saves the current MDI image using the current name.

SAVE AS...
Brings up the save as dialog box which you can use to save the picture file in the current MDI to a 
new name or format.    See also Save File As.

APPEND
Appends the image to the current MDI image file name.    This option is used to create a multi-image 
file.    Only TIFF and OS/2 BMP formats support multi-image files.    Use the Page Up, Page Down 
options under the View menu to switch between pages.

DELETE FILE
Will delete the current MDI image file from the disk.

PRINT IMAGE
Brings up the print setup dialog box used to adjust the current MDI image printing settings.

PRINTER SETUP
Select the printer you wish to print your images too.    See also Printer Setup.

EXIT
Exits the Graphics VP Deluxe application.

RECENT FILE LIST
Lists the last four files opened.    Click on the name to re-open them.



Menu: Options

SETUP
You can adjust some of the program settings such as scroll increment, position zoom magnification, 
and program linkage.    See also Program Settings Information.

VIEW CLIPBOARD
Uses the Windows CLIPBRD.EXE program to view what is currently in the Windows clipboard.    The 
Windows Clipboard is a temporary storage area for information that you are copying or moving from 
one location to another.

SAVE AS WALLPAPER
You can set your Windows Wallpaper from the current MDI image.    First you bring up the .BMP file 
you wish to make your Windows Wallpaper.    If you have a picture in another format, just convert it to
a palette/.BMP format (which is required for Windows wallpaper) using Graphics VP Deluxe.    Then 
you choose the Save As Wallpaper option under the Options Menu.    You will be given the chance to 
backout if you change your mind.

RUN WINDOWS SCREEN SAVER
Initiates the current Windows Screen Saver program.



Menu: View

TOOLBAR
Show/Hide main toolbar.    See also Toolbar Help.

CUSTOM TOOLBAR
Show/Hide zoom/luminance toolbar.    See also Toolbar Help.

STATUS BAR
Show/Hide status bar.    See also Toolbar Help.

ZOOM
Allows you to increase or decrease the size of the current MDI image.    The picture file is not 
permanently changed.    See also Zoom Information.

CUSTOM ZOOM
Brings up the Zoom Toolbar which allows you to increase or decrease the size of the current MDI 
image.    The picture file is not permanently changed.    See also Zoom Information.

POSITION ZOOM (+)
Sets position zoom OUT on the current MDI image.    Click on the image to zoom.    Can also initiate 
from the Zoom Toolbar.    See also Zoom Information.

POSITION ZOOM (-)
Sets position zoom IN on the current MDI image.    Click on the image to zoom.    Can also initiate 
from the Zoom Toolbar.    See also Zoom Information.

SCROLLBARS
Menu option to Hide or Show the horizontal and vertical scrollbars for the current MDI image.    Can 
also initiate from the Zoom Toolbar.      See also Zoom Information.

CLIP
Turns on and off clip feature of current MDI image.    To create a clip region you hold down the left 
mouse button and drag the mouse.    See also Clip Information.

FIT TO PICTURE
The current MDI image will be reset to it's original size.    The picture file is not permanently changed.

FIT TO IMAGE WINDOW
The current image will be enlarged to the size of the image MDI Window size.    The picture file is not 
permanently changed.

FIT TO PARENT WINDOW
The current MDI image will be enlarged to the size of the Graphics VP Deluxe screen.    The picture 
file is not permanently changed.

FULL SCREEN, PICTURE SIZE



Shows the current MDI image at it's regular size centered in a full screen display.    Click the left 
mouse button to exit full screen display.    You can also show an image full screen by double clicking 
with the left mouse button on the current MDI image.    Click the left mouse button or press the ESC 
key to exit full screen view.

FULL SCREEN, SCREEN SIZE
Shows the current MDI image at full screen size.    Click the left mouse button or press the ESC key 
to exit full screen view.

PAGE UP
Multi-image files are only supported by the TIFF, OS/2 BMP, and DCX file format.    If there are 
multiple pages this option will be enabled.    Page up will to to the next page image.

PAGE DOWN
Multi-image files are only supported by the TIFF, OS/2 BMP, and DCX file format.    If there are 
multiple pages this option will be enabled.    Page down will to to the previous page image.



Menu: Image

ACQUIRE
Allows you acquire an image from any Twain compliant device such as scanners, digital cameras, or 
frame grabbers.    See also Acquire Information.

CLASS CONVERSION
Allows you to convert the class type of the current MDI image.    Options are Bilevel, Gray Scale, 
Palette, and True Color.

RESIZE
Resize is used to change the image's height and width to a specified size.    Resizing permanently 
changes the image data but does not automatically save it back to the file.    See also Resize 
Information.

ROTATE
Rotate the current MDI image by 90, 180, 270 degrees or choose your own angle.    See also Rotate 
Information.

FILTER
Filtering modifies the rate of change that occurs along feature edges in an image.    It can increase 
the intensity differences in a soft edge to make it appear sharper, or reduce the intensity difference in
a hard edge to smooth and soften it.    See also Filter Information.

FILTER PREVIEW
Use to see how the different filters change the current MDI picture.    See also Filter Preview 
Information.

LUMINANCE CONTROLS
Adjust brightness, contrast, and gamma on the current MDI image.    See also Luminance 
Information.

IMAGE INFORMATION
Shows image history information for the current MDI image.    See also Image History Information.



Menu: Tools

GRAPHICS EDITOR LINK
You define the path to this program using the SETUP option of the OPTIONS menu.    The current 
MDI will be passed to the program.    The program can be used to do additional editing of your 
images.    The default program is Paint Brush which comes with Windows.

GRAPHICS GALLERY LINK
You define the path to this program using the SETUP option of the OPTIONS menu.    A program like 
Graphics Gallery from SkiSoft Shareware can be used to find and display multiple images.    This can
be set to any executible program.



Menu: Window

TILE HORIZONTAL
Arranges the MDI windows horizontally.

TILE VERTICAL
Arranges the MDI windows vertically.

CASCADE
Arranges the MDI windows as cascading.

NEXT
Activates next MDI window.

ARRANGE ICONS
Arranges all minimized MDI windows.

DUPLICATE
Duplicates the current MDI window into a new MDI window.

CLOSE ALL
Closes all MDI windows.    You will be prompted to save any changed images.



Menu: Help

CONTENTS
This will take you to Help Contents for Graphics VP Deluxe.

SEARCH FOR HELP ON...
This will take you to Help Search for Graphics VP Deluxe.

USING HELP
This will take you to Help on using Windows Help.

SHORT CUT KEYS
This will take you to Help on Graphics VP Deluxe short cut keys.

ABOUT GRAPHICS VP DELUXE
This will take you to the Graphics VP Deluxe About dialog box.



Tool Bar Help

Main Toolbar
Zoom Toolbar
Luminance Toolbar
File Status Bar



Main Toolbar
Click on the Tool Bar button you want to see help on...



File Status Bar
The File Status Bar is located at the very bottom of the Graphics VP Deluxe window.    It contains the 
current MDI image Format, Class, Size, and Compression.    The file name can be found in the MDI 
window title bar.

When you make a permanent change to a picture, the status bar will show the Class, Format, Size, 
and/or Compression change, but the Name will be blank until you save it.

You can show/hide the File Status Bar using the Status Bar option under the View menu.



Registration
Graphics VP Deluxe & Graphics Gallery
Registration Form:
Address:
   Name:____________________________________________________________
   Company:_________________________________________________________
   Address1:________________________________________________________
   Address2:________________________________________________________
   City:___________________________  State:______  Zip:_____________
   Country:____________________________________
   Phone  Bus:______________ Home:_______________ Fax: _____________
   Online Service/EMail ID: ________________________________________

   Purchase: Graphics VP Deluxe with Graphics Gallery  $20  __  (#copies)
   Purchase: Graphics VP Deluxe Only                   $15  __  (#copies)
   Purchase: Graphics View/Print with Graphics Gallery $15  __  (#copies)
   Purchase: Graphics View/Print Only                  $10  __  (#copies)
   Purchase: Graphics Gallery Only                     $10  __  (#copies)
   Washington State Residence Add Sales Tax:  ________
   Total Dollars Enclosed:  __________

   Disk Type: 3.5 __ or 5 1/4 __;   High __ or Low __ Density
   Graphics VP Version Number:______  (found with menu option:HELP-ABOUT)
   Where you acquired Graphics VP Deluxe___________________________
   ________________________________________________________________
   Comments:_______________________________________________________
   ________________________________________________________________
   ________________________________________________________________
   ________________________________________________________________

To register send check or money order along with a printed copy of this
registration form to:

   SkiSoft Shareware
   3499 223rd Street SW
   Brier, WA  98036

For more information, I can be contacted online through:

CompuServe ID       73042,3371
America Online ID   Skibby
Internet            http://users.aol.com/skisoft1
                    73042.3371@compuserve.com
                    Skibby@aol.com 

Thank You!!



CompuServe Registration
If you have a CompuServe account, you can use the on-line software registration service.    This 
service will charge your CompuServe account, and will automatically send SkiSoft an E-mail 
message notifying us that you have registered the SkiSoft product.    

To use this service, go to the SWREG forum on CompuServe.
Search for one of the following Registration IDs:

· Graphics VP Deluxe with Graphics Gallery: 10542
· Graphics View/Print with Graphics Gallery: 8314
· Graphics View/Print: 8311
· Graphics Gallery: 8313
        
You will receive a serial number by E-mail (usually within 24 - 48 hours) which will register your 
current copy, and the latest release will be mailed to you.



How To Contact Us
On-Line

You can contact us using the following e-mail ids:

America Online - Skibby
CompuServe - 73042,3371
Internet - Skibby@aol.com or 73042,3371@compuserve.com

Also, you can visit our Internet site for company and product information and downloads:

http://users.aol.com/skisoft1

Mail

SkiSoft Shareware
3499 223rd Street SW
Brier, WA 98036



License Agreement
This program is a "shareware program" and is provided at no charge to the user for evaluation.    Feel
free to share it with your friends, but do not give it away altered or as part of another system.    If you 
find this program useful and continue to use it after 30 days, you must make a registration payment 
to SkiSoft Shareware for the fee specified on the registration form found in the program's help file.    
The fee will license one copy for use on any one computer at any one time.    If used on a network 
system, each user is considered to be using a distinct copy of the licensed program whether or not 
he or she is actually using it.    Site-License arrangements may be made by contacting SkiSoft 
Shareware.

Anyone distributing this program for any kind of remuneration must first contact SkiSoft Shareware at
the address contained in the help file for authorization.

SkiSoft Shareware warrants that for a period of ninety days from the date of delivery of the licensed 
program, the program, if unmodified by the Licensee, will perform in substantial conformity with the 
user documentation.    SkiSoft Shareware does not warrant that the licensed program is free from 
coding errors.    Any modifications to the licensed program shall thereafter be licensed AS IS.

The above warranty does not apply to the extent that any failure of the licensed program to perform 
as warranted is caused by the licensed program being (1) not used in accordance with the user 
documentation, or (2) modified by any person other than authorized SkiSoft Shareware, Inc. 
personnel.

LICENSOR MAKES AND LICENSEE RECEIVES NO OTHER WARRANTY OF ANY KIND, 
EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY WARRANTIES OF 
MERCHANTABILITY AND/OR FITNESS FOR A PARTICULAR PURPOSE.

The total liability of SkiSoft Shareware for any claim or damage arising out of the use of the licensed 
program or otherwise related to this license shall be limited to direct damages which shall not exceed
the license fee(s) which have been paid by Licensee to SkiSoft Shareware for the specific client 
project which is the subject of such claim or damage.

IN NO EVENT SHALL LICENSOR BE LIABLE TO LICENSEE FOR ADDITIONAL DAMAGES, 
INCLUDING ANY LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE 
LICENSED PROGRAM, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

UNISYS Corporation TIFF-LZW/GIF-LZW Software Patent License Grant:

Unisys herby grants to Licensee SkiSoft Shareware a non-exclusive, worldwide license under the 
Licensed Patent (with no right to sublicense) restricted to the Field of Use to make, have made, use, 
sell or otherwise transfer Licensed Software to End users either directly or via Third Parties.

GIF/TIFF - LZW Capability Licensed under U.S. Patent No. 4,558,302 and foreign counterparts by 
UNISYS Corp.



Shareware
Shareware distribution gives users a chance to try software before buying it.    If you try a Shareware 
program and continue using it, you are expected to register.    Individual programs differ on details    --
some request registration while others require it,    some specify a maximum trial period.    With 
registration, you get anything from the simple right to continue using the software to an updated 
program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains 
all rights, with a few specific exceptions as stated below.    Shareware authors are accomplished 
programmers,    just like commercial authors, and the programs are of comparable quality.    (In    both 
cases, there are good programs and bad ones!)    The main difference is in the method of distribution.
The author specifically grants the right to copy and distribute the software, either to all and sundry or 
to a specific group.    For example, some authors require written permission    before a commercial 
disk vendor may copy their Shareware.        

Shareware is a distribution method, not a type of software.    You should find software that suits your 
needs and pocketbook, whether it's commercial or Shareware.    The Shareware system makes fitting
your needs easier,    because you can try before you buy.    And because the overhead is low, prices 
are low also.    Shareware has the    ultimate money-back guarantee -- if you don't use the product, 
you don't pay for it.



Copyright
Graphics VP Deluxe Copyright    ©    1996 by SkiSoft Shareware    All Rights Reserved.

Portions Copyright    ©    1994-1996 by Media Cybernetics.

The Tiff and/or GIF LZW compression/decompression capability included in this software is licensed 
under U.S. Patent No. 4,558,302 and foreign counterparts.



Filter Preview
Use to see how the different filters change the current MDI picture.    Left mouse click on the filter 
name on the list.    The sample preview window will show the changes.    When you click on another 
filter name, the original MDI picture will be used or use the UNDO button to return the preview image 
to the original.

To apply the changes, click on the APPLY button and the current MDI picture will show the changes.

To cancel the changes and return to the original picture, click on the CANCEL button.

See Also
Filter options



Main Toolbar: ACQUIRE

Display of the Acquire dialog.    Use to acquire images from any Twain compliant devices such as 
scanners, digital cameras, and frame-grabbers.



Main Toolbar: CLIP

Turns clip on and off for the current MDI image.



Main Toolbar: COPY

Copy the current MDI Image or clip of the current MDI Image to the clipboard.



Main Toolbar: CUT

Cut the current MDI Image or clip of the current MDI Image to the clipboard.



Main Toolbar: FILTER PREVIEW

Preview image enhancements using current MDI image.



Main Toolbar: FIT TO PICTURE

Show current MDI image at original picture size.



Main Toolbar: FIT TO SCREEN

Show current MDI image at Graphics VP Deluxe screen size.



Main Toolbar: GRAPHICS EDITOR

Used to pass the current MDI image to the Graphics Editor program specified in Program Settings.



Main Toolbar: GRAPHICS GALLERY

Used to run a Graphics Gallery program such as Graphics Gallery by SkiSoft Shareware.    Can be 
used to run any executible program.



Main Toolbar: HELP

Show Graphics VP Deluxe Windows Help File, Contents.



Main Toolbar: LUMINANCE

Display of the Luminance Toolbar.    This allows adjustment of the brightness, contrast, and gamma 
settings for the current MDI image.



Main Toolbar: NEW

New file.    Creates an empty MDI image window.



Main Toolbar: OPEN

Open a new MDI image window using a file selected from the open file dialog.



Main Toolbar: PASTE

Paste what is in the clip board to the current MDI Image window.    Contents of the clipboard must be 
a graphic and not text.



Main Toolbar: PRINT

Print the image shown in the current MDI Image window.



Main Toolbar: SAVE AS

Brings up the save as dialog box.



Main Toolbar: CLIP MEASUREMENT

Displays the clip measurements.    When clip is off you will see the cursor location over each image 
(width x height).    When clip is on you will see the starting and ending locations of the clip box as well
as th size of the clip box.



Main Toolbar: UNDO

Undo the last change made to the current MDI Image.



Main Toolbar: ZOOM

Display of the Zoom Options Toolbar.    This allows setting of the scrollbars, position zoom, custom 
zoom, slider bar zoom, and zoom reset to 100% for the current MDI image.



Image Information
This dialog shows image information about the currently selected MDI image.    This information 
includes:

File name, format, compression, page, size Information, class, artist, title, date, and description.    

The Artist, Title, and Description can only be input and changed for images saved with the File 
Format TIFF.



Open
Opens an existing image in a new window.    You can also open one of the most recently saved 
images by selecting the name from the bottom of the File menu or clicking the Open Button on the 
GVPD main toolbar. 

Open Dialog Box Options
File Name - Select or type the name of the file you want to open

List Files Of Type - Select the type of files you want to see in the File Name list.

Directories - Select the directory that contains the file you want to open.

Drives - Select the drive that contains the file you want to open.

Network - Opens the Connect Network Drive dialog box so you can make a connection to a network 
drive.



Paste Special
Will paste the contents of the clipboard to the current MDI image using the merge mode selected 
(Copy, And, Or, Nand, Nor).    The contents of the clipboard must be a graphics format.    There are 5 
ways to Paste Special:

1 Copy - Works like a regular paste command.
2 And - Source and destination pixel values are ANDed.    Only bit values that are "on" in both 

images are "on" in the result.
3 Or - Source and destination pixel values are ORed.    Bit values that are "on" in either images are

"on" in the result.
4 Nand - Source and destination pixel values are NANDed.    Bit values that are "off" in either or 

both images are "on" in the result.
5 Nor - Source and destination pixel values are NORed.    Bit values that are "off" in both images 

are "on" in the result.

Contents of the clipboard must be a graphic and not text.



Save As
Save As allows you to save the current MDI image to a different directory, file name, graphics format,
and/or graphics class.    For certain picture types you can also set the compression factor, and adjust 
the picture quality.

File Name, Directory, Drives
The controls for these functions work like standard Windows dialog boxes.    Select the Drive from the
drop down list, then double click in the Directory until you find the one you want, then all files 
associated with the file name will be displayed.    Double click on the one you want, or highlight it and 
click on the OK button.

File Class
Image Class Information

File Format
File Formats

Compression
· No Compression - some image formats do not support an uncompressed format.
· Default - use the default compression method for the specified format and image class.
· RLE - use the Run Length Encoding compression method.
· CCITT 1D - use CCITT Modified Huffman, 1-Dimensional encoding.    TIFF only.
· CCITT Group 3 - use CCITT Group3 Fax encoding.    TIFF only.
· CCITT Group 4 - use CCITT Group4 Fax encoding.    TIFF only.
· LZW - use modified Lempel-Zif encoding.    TIFF and GIF formats only.
· LZW Horz Predictor - use modified Lempel-Zif encoding with horizontal differencing predictor.    8 

bits per pixel TIFF only.
· JPEG - use JPEG compression with the quality factor specified.    JPEG only.

More Compression Information...

JPEG Quality
Sets the quality factor that is to be used when an image is stored in JPEG format.    A certain amount 
of information can be lost when an image is stored in the JPEG format.    JPEG Quality lets you 
control the amount of information loss.    High JPEG Quality values retain more image data, but do 
not result in small files, whereas low JPEG Quality values create very compact files, but eliminate 
more visual information.



Zoom Toolbar: ZOOM 100%

Click on this button to return the current MDI Image to 100% zoom, it's original size.



Zoom Toolbar: APPLY ZOOM

Click on this button to apply the zoom entered in the zoom text box.



Zoom Toolbar: HORIZONTAL SCROLLBAR INCREMENT

Enter the horizontal scrollbar increment in this text box.    Different images will require different 
settings for optimal scrollbar movement.



Zoom Toolbar: SHOW/HIDE SCROLLBARS

Click on this button to show or hide the scrollbars on the current MDI Image.



Zoom Toolbar: SHOW/APPLY ZOOM INCREMENT SETTINGS

Click on this button to display the scrollbar incremental text boxes.    After entry, click again to save 
the settings.



Zoom Toolbar: ZOOM SLIDER

Click on this slider bar to adjust the zoom (up or down) of the current MDI image.    The results will 
show in the zoom text box.



Zoom Toolbar: ZOOM DISPLAY

Displays the current zoom setting of the current MDI image.    You can enter a zoom amount betwee 
1 and 1600 in this box and click on the "Apply Zoom" button to apply it to the current MDI image.



Zoom Toolbar: VERTICAL SCROLLBAR INCREMENT

Enter the vertical scrollbar increment in this text box.    Different images will require different settings 
for optimal scrollbar movement.



Acquire Information
<Acquire>



acquire
<Acquire>



brightness
Graphics VP Printing, 0,<Luminance Toolbar>



cap



class
<Class>



Clip Information
<Clip>



clip
<Clip>



compression
<Compression>



contrast
<Contrast>



convert
<Convert>



enhance
<Filter>



file types
<File Formats>



Filter Information
<Filter>



Filter Preview Information
<Filter Preview>



Filter Preview
<Filter Preview>



Filter
<Filter>



gamma
<Gamma>



Graphics View/Print
This program is similar to Graphics VP Deluxe but it does not have all the conversion and image 
enhancements features.



halftone
<Halftone>



Image History Information
<Image Information>



Luminance Information
<Luminance Toolbar>



luminance
<Luminance Toolbar>



MDI
Multiple Document Interface.    Allows you to show multiple images windows in Graphics VP Deluxe.



Open File
<Open>



Paste Special Information
<Paste Special>



print
<Graphics VP Printing>



Printer Setup
<Print Setup>



Program Settings Information
<Program Settings>



Resize Information
<Resize>



resize
<Resize>



Save File As
<Save As>



scanned
<Acquire>



Toolbar Help
<Tool Bar Help>



view
<View>



Zoom Information
<Zoom>



zoom
<Zoom>






